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How to Use This Manual
This section shows how to use this manual.
Cover page

Contents page

Index page

Common Note:
To display or print this manual, either Adobe® Acrobat® (7.0 or later) 
or Adobe® Reader® (7.0 or later) is required.
Clicking a blue character string (where the mouse pointer changes 

into a link-selecting icon such as  while pointing) moves to the 
reference.

In this manual, you can use the Search tool of Adobe® Acrobat® or 
Adobe® Reader®.
For details, refer to Adobe® Acrobat® or Adobe® Reader® Help.
On the keyboard, press the [PageUp] key to move to the previous 
page, and the [PageDown] key to the next page.

Jumps to the 
top page of 
each chapter. 

TOP: Jumps to the cover page. 
Contents: Jumps to the contents page. 
Index: Jumps to the index page. 

Jumps to this 
page.

Jumps to the page of the title that is clicked. 

Jumps to the page of the index that is clicked. 
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Thank you for using ScandAll PRO.

Overview of ScandAll PRO
ScandAll PRO is an application that enables you to display 
and edit images scanned with a fi-series Image Scanner.
This manual describes how to use ScandAll PRO for scanning 
with a fi-series Image Scanner.
For details about the functions of ScandAll PRO, refer to the 
"ScandAll PRO Help".

Trademarks
Microsoft, Windows, Windows Server, Windows Vista, and 
SharePoint are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other 
countries.
ISIS is a registered trademark of EMC Corporation in the 
United States.
Adobe, the Adobe logo, Acrobat, and Adobe Reader are either 
registered trademarks or trade names of Adobe Systems 
Incorporated in the United States and/or other countries.
Kofax and VRS are trademarks or registered trademarks of 
Kofax, Inc.
Other company names and product names are the registered 
trademarks or trademarks of the respective companies.

Manufacturer
PFU LIMITED
International Sales Dept., Imagi
Products Group
Solid Square East Tower, 580 H
Kawasaki-shi Kanagawa 212-85
Phone: (81-44) 540-4538
All Rights Reserved, Copyright ©

Use in High-Safety Applic
This product has been designed
assumption that it will be used in
regular industrial, and general p
It has not been designed and m
applications (simply called "high
here on) that directly involve dan
high degree of safety is required
nuclear reactions at nuclear pow
control of aircraft, air traffic cont
transport systems, medical equi
missile firing control in weapons
provisionally the safety in questi
The user should use this produc
ensuring safety in such high-saf
LIMITED assumes no liability wh
from use of this product by the u
applications, and for any claims 
by the user or a third party.
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een the different versions of the 
ral term "Windows" is used.

bit)
64-bit)

t)

Windows 
Vista

Windows
(*1)

/64-bit) Windows 
Server 2008

bit) Windows 7

 Server Microsoft
SharePoint Server

r 2007

Adobe Acrobat 

Indication
Symbols Used in This Manual
In this manual, the following symbols are used to describe 
operations as well as indicate warnings.

Abbreviations Used in This Manual
The following abbreviated terms used in this manual are 
described.

*1 : Where there is no distinction betw
above operating system, the gene

！！！
This symbol alerts operators to particularly important 
information. Be sure to read this information.

This symbol alerts operators to helpful advice regarding 
operation.

Product Indication

Windows® XP Home Edition
(Service Pack 2 or later)
Windows® XP Professional 
(Service Pack 2 or later)
Windows® XP Professional x64 Edition

Windows 
XP

Windows
(*1)

Windows Server® 2003 R2, Standard 
Edition
Windows Server® 2003 R2, Standard x64 
Edition

Windows 
Server 2003

Windows Vista® Home Basic (32/64-
Windows Vista® Home Premium (32/
Windows Vista® Business (32/64-bit)
Windows Vista® Enterprise (32/64-bi
Windows Vista® Ultimate (32/64-bit)

 Windows Server® 2008 Standard (32
 Windows Server® 2008 R2 Standard
 (64-bit)

Windows® 7 Home Premium (32/64-
Windows® 7 Professional (32/64-bit)
Windows® 7 Enterprise (32/64-bit)
Windows® 7 Ultimate (32/64-bit)

Microsoft® Office SharePoint® Portal
2003

Microsoft® Office SharePoint® Serve

Adobe® Acrobat®

Product
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Description of Successive Operations
In the procedures described in this manual, successive
operations are connected with  in between.

Example: Click the [Scan] menu  [Scan Settings].

Screen Examples in This Manual
The screen examples in this manual are subject to change 
without notice in the interest of product improvement.
If the actual displayed screen differs from the screen 
examples in this manual, operate by following the actual 
displayed screen while referring to the user's manual of the 
scanner application you are using.
The screen examples used in this manual are of TWAIN 
driver, ISIS driver, ScandAll PRO (which is an image capturing 
application), and Adobe Acrobat.
The screen examples used in this manual are of Windows 
Vista. Depending on the operating systems you are using, the 
screen examples and operations may differ from the actual 
ones. Also note that, depending on the scanner model, 
screens and operations stated in this manual may differ when 
you update TWAIN driver/ISIS driver. In this case, refer to the 
manual provided upon updating the driver(s).

Scanner Component Names in This Manual
The button names on the scanner and the name of the display 
area of the operator panel described in this manual may differ 
depending on the scanner you are using.
In this case, refer to the Operator’s Guide for your scanner.
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This chapter describes the overview and features of ScandAll PRO.

1.1 What is ScandAll PRO?.................................................................................................

1.2 Features ........................................................................................................................
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1.1 What is ScandAll PRO?

ScandAll PRO
ScandAll PRO is an application for scanning images, which 
conforms with both the TWAIN and ISIS standards.
Used with a TWAIN or ISIS driver, ScandAll PRO allows you 
to scan a document to convert it into image data. You can also 
scan a document with a VRS (*1) ISIS interface.
ScandAll PRO is suitable for routine task input, such as 
computerizing business or application forms.
*1: An application that can easily create high-quality images. VRS can also 

detect and automatically correct errors that may occur while scanning. 
For a example, scanning documents containing skewed or smudged 
characters due to the colored or shaded effects.

For details about the functions of ScandAll PRO, refer to the 
ScandAll PRO Help.
If your scanner does not support VRS, you cannot use VRS.
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Text-recognizes scanned barcode data or a part of the image with 
to the indexing information file.
n while using the output image file 
arameter.
images, and if any exist, changes 
t thumbnail. (fi-6800 only)
 images by changing the 
 be easily sorted.

1.2 Features

Feature of ScandAll PRO
ScandAll PRO has the following features:

■ Various Scan Settings
Conforms with both TWAIN/ISIS standards.
Allows batch processing (batch scan), enabling scan operations with 
scan conditions, file format, and file save destination specified. You 
can also save the specified scan settings as a profile.
Has hot key controls, enabling batch scan operations with a single 
touch on a keyboard.
Allows events to be set, enabling batch scan operations with a single 
press of the [Scan] or [Send to] button.

■ Display/Edit/Save Functions to Meet Your Needs
Shows multiple files side-by-side for comparison.
Allows you to edit the scanned images in various ways such as 
rotating, reverting, deskewing, sorting, and page-insertion and 
deletion. You can save the edited data as a new file, or resave it with 
the profile settings used for the scan.
Outputs both color and monochrome images simultaneously with a 
single scan. (When using a scanner that supports the multi-image 
output function.)
Inputs/outputs Bitmap, JPEG and TIFF files.
Outputs the scanned images in PDF or PDF/A file format. You can 
also create searchable PDF files and high-compression PDF files.

■ Other Useful Functions
Automatically saves the scanned images in the specified server by 
linking with FTP server or Microsoft SharePoint Server.
Sends the scanned images as an attached file by linking with an 
e-mail program.
Classifies pages of a document in a specified unit and saves them in 
separate files by using patch codes or barcodes.

Zone OCR, and outputs the data 
Launches the specified applicatio
or indexing information file as a p
Checks for errors in the scanned 
the background color of the targe
Marks thumbnails of the scanned
background color so that they can
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How to Use ScandAll P
This chapter describes how to scan documents with the scanner using ScandAll PRO.

2.1 Launching ScandAll PRO..............................................................................................

2.2 Selecting a Scanner Driver............................................................................................

2.3 Selecting a Scanner Model............................................................................................

2.4 Scan Parameters...........................................................................................................

2.5 Scanning Methods.........................................................................................................

2.6 Scanning with [Scan] .....................................................................................................

2.7 Scanning with [Batch Scan]...........................................................................................

2.8 Advanced Scanning.......................................................................................................

2.9 Useful Post-Scan Functions ..........................................................................................
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2.1 Launching ScandAll PRO
1 Select the [Start] menu  [All Programs]  [Fujitsu 
ScandAll PRO]  [ScandAll PRO].

ScandAll PRO starts up.
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her of the drivers under 

e the settings.

2.2 Selecting a Scanner Driver

A fi-series Image Scanner comes with two scanner drivers; a 
TWAIN driver that conforms with the TWAIN standard, and an 
ISIS driver that conforms with the ISIS standard.
ScandAll PRO supports both drivers, and there is no 
significant difference between them. Choose one to suit your 
requirements. 
The following explains how to select the scanner driver (switch 
between TWAIN and ISIS) to use with ScandAll PRO.

1 Select the [Tool] menu  [P
The [Setup] dialog box appea

2 On the [Scan] tab, select eit
[Device Driver].

3 Click the [OK] button to sav

In ScandAll PRO, [TWAIN] is selected by default.
For functional details of the TWAIN driver, refer to the 
TWAIN Driver Help.
For functional details of the ISIS driver, refer to the ISIS 
Driver Help.
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ISIS driver:

2.3 Selecting a Scanner Model

You need to select a scanner to use before you scan a 
document.
The following explains how to select the scanner.

1 Select the [Scan] menu  [Select Scanner].
The [Select Scanner] dialog box appears.

2 Select a scanner you want to use, and click the [Select] 
button.
Select the scanner model that you connected to your computer. Note 
that the indication of the scanner model name depends on the 
selected scanner driver.

TWAIN driver:
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ISIS driver:

n the respective drivers, refer to the 
 you are using.

the settings, click the [OK] 

igured.

2.4 Scan Parameters

The scan parameters are configured in the scanner driver’s 
setup dialog box.

1 Select the [Scan] menu  [Scanner Setting].
The scanner driver's setup dialog box appears.

TWAIN driver:

For the configurable parameters i
Operator’s Guide for the scanner

2 When you have completed 
button.

The scan parameters are conf

The scanner driver’s setup dialog box specifications differ 
depending on the scanner.
For details, refer to the Operator’s Guide for the scanner you 
are using.
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2.5 Scanning Methods
There are two ways to scan documents by using ScandAll 
PRO.

Scanning with [Scan]

Use this option when scanning a small number of pages.
Each time you scan documents, you may need to configure 
new settings as necessary, such as the file format, saving 
destination, and scan parameters.
For details, refer to "2.6 Scanning with [Scan]" (page 17).

Scanning with [Batch Scan]

Use this option when scanning a large number of pages.
You can save scan settings as a "profile" in advance, and scan 
documents according to the profile.
Profiles are configured for scan settings such as the file 
format, saving destination, scan parameters, image 
processing properties, and application with which to interact. 
You can create more than one profile beforehand, so you do 
not have to configure new settings every time you scan 
documents. You only need to switch between profiles.
For details, refer to "2.7 Scanning with [Batch Scan]" (page 
20).
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 box, configure various 

the scanned images.

2.6 Scanning with [Scan]

he setting items you can configure, 
RO Help.
Each time you scan documents, you may need to configure 
new settings as necessary, such as scan and saving 
parameters.

1 Load a document on the scanner.
For how to load a document on the scanner, refer to the Operator’s 
Guide for the scanner you are using.

2 Select the [Scan] menu  [Scan Settings].
The [Scan Settings] dialog box appears.

3 In the [Scan Settings] dialog
settings such as for saving 

For information about t
refer to the ScandAll P
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4 Click the [Scanner Setting] button. 5 Configure the scan parameters.
For the configurable parameters in the respective drivers, refer to the 
Operator’s Guide for the scanner you are using.

the settings, click the [OK] 

Settings] dialog box.

 driver, clicking the [Scan] button 
r driver's setup dialog box. If so, 
e settings in the dialog box 

 to scan the document.
 when you finish scanning.

splay the scanner driver's setup 
how TWAIN dialog before each 
eck box in the [Scan Settings] 
The scanner driver's setup dialog box appears.

TWAIN driver:

 ISIS driver:

6 When you have completed 
button.

You are returned to the [Scan 

7 Click the [Scan] button.

T.B.D
When using the TWAIN
may display the scanne
you can also change th
displayed.
Click the [Scan] button
Click the [Close] button

If you do not want to di
dialog box, clear the [S
batch scan process] ch
dialog box.
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After the document is scanned, the scanned image(s) are 
displayed on the ScandAll PRO window, and then saved to a file.
For information about scanning methods other than scanning with 
[Scan], refer to "2.8 Advanced Scanning" (page 23).

If you clear the [Save to file] check box in the [Scan 
Settings] dialog box, the scanned image(s) will no 
longer be saved to a file. To save the image(s) to a file, 
select the [File] menu  [Save As].
To scan documents with the same settings afterwards, 
select the [Scan] menu  [Scan].
For more details about the functions and operations of 
ScandAll PRO, refer to the ScandAll PRO Help.



TOPChapter 2 How to Use ScandAll PRO

20

How to Use 
ScandAll PRO

Overview of 
ScandAll PRO

Contents
Index

Introduction
ry:

 [Profile Editor] dialog box.

on an existing profile:
ange the settings for, and click the 

m the profile list is displayed as a 
itor] dialog box.

xisting profile:
ange the settings for, and click the 

s in the [Profile Editor] dialog box.

m the profile list:
lete, and then click the [Delete] 

ed.

ofile is added in the profile list.

2.7 Scanning with [Batch Scan]

With Batch Scan, you can save various settings as profiles 
beforehand and then scan documents by using such profiles.

Creating and Editing Profiles

1 Select the [Scan] menu  [Batch Scan Settings].
The [Batch Scan Settings] dialog box appears.

2 Do the following as necessa
To create a new profile:
Click the [Add] button.

A new profile appears in the

To create a new profile based 
Select a profile you want to ch
[Copy] button.

The profile you selected fro
new profile in the [Profile Ed

To change the settings of an e
Select a profile you want to ch
[Edit] button.

The selected profile appear

To delete an existing profile fro
Select a profile you want to de
button.

The selected profile is delet

When you create a profile, the pr

Profile List
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3 In the [Profile Editor] dialog box, configure settings for 
scanning and saving the scanned images.

 Scan Settings] dialog box.
ing the [Add] or [Copy] button are 

driver, only [00: Current Setting] is 
ile] in [Scanner Settings].

he setting items you can configure, 
RO Help.
4 Click the [OK] button.
You are returned to the [Batch
Added or copied profiles by us
added to the profile list.

The profile showing [Template] at [Type] in the dialog 
box is a default sample profile. It cannot be used for 
actual scanning. Use this profile as the base of new 
profiles.
When the title line of each parameter in the profile list is 
clicked, profiles other than [Template] are sorted. 
You can specify the initial setting values beforehand.

1 Select the [Tool] menu  [Preferences] and specify 
a profile name for [Initial setting for profile] on the 
[Scan] tab.

2 For [Batch Scan Setting], create a profile with the 
same name as the one you specified.

3 An asterisk (*) is displayed to the right of the profile 
type, to indicate that default values are used for the 
profile settings. When you create a new profile with 
the [Add] button, the profile is created with the 
default settings values.

！！！
When you use TWAIN 
available for [Setting F

For information about t
refer to the ScandAll P
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Scanning Documents

1 Load a document on the scanner.

After the document is scanned, the scanned image(s) are 
displayed on the ScandAll PRO window, and then saved to a file.

an by using the [Scan] menu or by 
in the [Batch Scan Settings] dialog 
e information, refer to the ScandAll 

is performed, the batch scan 
porarily saved automatically. 
orking state is temporarily saved 
ofile at a time, the saved state is 
ith the one last used. The 
tch scan working state can be 

can] menu  [Restore Batch 
 how to restore a batch scan, refer 
pended Batch Scan" (page 48). 
pended, inserted, replaced, or 
ent batch, or scanned images are 
ng a batch scan, you can save the 
om the [File] menu  [Save].
2 Select a profile from the [Select the Batch Profile] drop-
down list on the toolbar.

3 Click the [Start Batch Scan] button.

You can perform a sc
configuring settings 
box as well. For mor
PRO Help.
When a batch scan 
working state is tem
Because only one w
for each scanning pr
always overwritten w
temporarily saved ba
restored from the [S
Scan]. For details on
to "Restarting a Sus
If another scan is ap
added to the docum
edited after performi
changed contents fr
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2.8 Advanced Scanning
Launching the TWAIN driver from ScandAll PRO allows you to 
scan documents by various methods.
The following shows the scanning methods list.

Scanning Methods List

Changing the scanning method
"Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S)" 
(page 24)

Setting post-scan operations and processes
"Saving Scanned Images in PDF File Format" (page 26)
"Dividing a Multipage Document Using Patch Codes" (page 28)
"Dividing a Multipage Document Using Barcodes" (page 30)
"Specifying the Result of Zone OCR as a File Name" (page 37)
"Specifying the Result of Barcode Recognition as a File Name" (page 
41)
"Creating Saving Folders for Each Batch Scan" (page 44)
"Saving Scanned Images from a Batch Scan to a Microsoft 
SharePoint Server" (page 46)
"Restarting a Suspended Batch Scan" (page 48)
"Outputting Indexing Information File and Linking with an Application" 
(page 49)
"Detecting Errors in the Scanned Document (fi-6800)" (page 51)

Changing the scanner’s scan responses
"Using the Scanner Buttons to Start a Scan Quickly" (page 34)
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Duplex Scanning Using the ADF Virtual Duplex 
Option (fi-6750S)

The ADF Virtual Duplex option allows you to scan the front of 

When selecting the Batch Scan option
Display the profile to be used for scanning in the [Profile Editor] dialog 
box. On the [Scan] tab, select [ADF (Virtual Duplex)] from [Scan 
Type].

ver
 box, select [ADF (Virtual Duplex)] 

 box, you cannot configure 
 duplex scanning. When using this 
Settings] dialog box or use the 
the pages of a document first, and then scan the reverse sides 
in succession. It then automatically sorts these scanned 
pages in the correct order.

1 Load a document face down on the ADF paper chute.
For how to load a document on ADF paper chute, refer to the 
Operator’s Guide for the scanner you are using.

2 In ScandAll PRO, specify Duplex Scan mode.
When selecting the Scan option
Select the [Perform ADF virtual duplex scanning] check box in the 
[Scan Settings] dialog box.

When using a scanner dri
In the [TWAIN Driver (32)] dialog
from [Scan Type].

JKL JKL

JKL JKL

DEF

1 2
3 4
5 6

1
2
3
4
5
6

ABC DEF

ABC

Front Side

Sort
(Auto)

Back Side

In the ISIS driver dialog
settings for ADF virtual
driver, go to the [Scan 
Batch Scan option.
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3 Perform a scan with ScandAll PRO.
When the scanning is complete, a message appears to prompt 
you to reload the document face up. ！！！

The ADF Virtual Duplex option is not available once 
you have selected any of the following. To use the 
option, change the settings in ScandAll PRO or in the 
scanner driver.

 and monochrome simultaneously] 
d monochrome automatically] 
e [File format and Name scheme] 

Editor] dialog box.
er of Pages per Separator], [Use 
 Job Separation Sheet], [Use 
ob Separation Sheet], and [Use 
Job Separation Sheet] check 
cument separator] tab in the 
log box.
Output] check box in the [Multi 
, which is opened by clicking the 

ge] check box in the [TWAIN Driver 
f the TWAIN driver.
and [Blank Page Skip] check 
on] dialog box, which is opened by 
n] button in the [TWAIN Driver 
f the TWAIN driver.
x under [Blank Page Deletion] on 
eletion] tab of the ISIS driver.

 #1] and [Front Image #2] check 
a] under [Image Mode] on the 
g] tab of the ISIS driver.
s are not sorted if the page count 
iffers from that on the back side.
4 Load the document face up on the ADF paper chute.
For how to load a document on ADF paper chute, refer to the 
Operator’s Guide for the scanner you are using.

5 Click the [Yes] button.

The reverse sides of the pages are scanned.
When the scanning is complete, the pages of the scanned 
document are sorted automatically.

！！！
When scanning the reverse sides of the pages of a 
document, carefully load the document so that:

The document is scanned from the last page.
The pages are not upside down.

- The [Output color
and [Sort color an
check boxes on th
tab in the [Profile 

- Any of the [Numb
Patchcode-Based
Barcode-Based J
Hardware-Based 
boxes on the [Do
[Profile Editor] dia

- The [Multi Image 
Image] dialog box
[Enable Multi Ima
(32)] dialog box o

- The [Split Image] 
boxes in the [Opti
clicking the [Optio
(32)] dialog box o

- The [On] check bo
the [Blank Page D

- The [Front Image
boxes for [Camer
[Image Processin

The scanned image
on the front pages d
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Saving Scanned Images in PDF File Format

ScandAll PRO allows you to create PDF data easily without 
any special steps. By changing the compression rate, you can 

When scanning with the Scan option
Select a file format from [File Format] in the [Scan Settings] dialog 
box.

 Scan option
o use for scanning your file in the 
the [File format and Name scheme] 
from [File Format].
reduce the size of PDF data.
ScandAll PRO is recommended for scanning in color or 
grayscale mode.

The procedure is as follows:

1 Load a document on the scanner.
For how to load document on the scanner, refer to the Operator’s 
Guide for the scanner you are using.

2 In ScandAll PRO, select the file format to save the 
scanned images from the following:

PDF File
SinglePage PDF File
PDF/A File
SinglePage PDF/A File

When selecting the Batch
Display a profile name you want t
[Profile Editor] dialog box. Select 
tab, and then select a file format 

A [PDF File] or [SinglePage PDF File] is saved in a format 
compatible with Adobe Acrobat 4.0 (PDF 1.3), while a 
[PDF/A File] or [SinglePage PDF/A File] saved in a PDF/
A-lb format (format for an archive of digital documents 
based on PDF 1.4).
Selecting [SinglePage PDF File] or [SinglePage PDF/A 
File] creates one file per scanned image, and selecting 
[PDF File] or [PDF/A File] creates one file containing 
multiple scanned images.
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3 To configure PDF-related optional settings, click the [PDF 
Option] button.

The [Output PDF File] dialog box appears.
In this dialog box, you can change the compression rate for creating a 
file, make searchable PDF files, and set a password to open a PDF 
file.

4 Perform a scan with ScandAll PRO.

For details about the [Output PDF File] dialog box, refer to 
the ScandAll PRO Help.

！！！
ScandAll PRO features the outputting of scanned images 
as PDF file(s), but does not officially support the function 
to open PDF files. You can forcibly open files, but they 
may not be displayed correctly, and operation may be 
unstable.
To view PDF files, it is recommended to use an 
application that can open PDF files, such as Adobe 
Acrobat.
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Dividing a Multipage Document Using Patch 
Codes

ScandAll PRO supports the Job Separation function using 

2 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

ator] tab, and then select the 
 Separation Sheet] check box.

nning of patch code sheet images, 
separation sheet] check box.
e, you can disable the scanning of 
h code sheet by selecting the 
ge of a separation sheet] check 
patch code sheets. This function allows you to divide scanned 
images of a multipage document by a specified unit without 
interrupting the ongoing scan, and save them respectively in 
separate folders. When the output file format is set to 
multipage PDF or TIFF, and multipage document is scanned, 
the pages can be divided by the specified unit and saved as 
separate files.

The procedure is as follows:

1 Prepare patch code sheets.
The PDF file for use as a patch code sheet comes with two size types 
(A4 and Letter). Before using the patchcode-based Job Separation 
function, you need to select the [Start] menu  [All Programs]  
[Fujitsu ScandAll PRO]  [Patch Code]  [Job Separation (A4)] or 
[Job Separation (Letter)], and then print the PDF file of either "Job 
Separation (A4)" or "Job Separation (Letter)" as many as you need.

3 Select the [Document separ
[Use Patchcode-Based Job

！！！
Take note of the following when you print out a patch 
code sheet:
- Use blank white paper.
- Set the scaling to 100%.

The sheet is not recognized correctly when printed 
in a size smaller than the original.

- Do not save toners. 
The sheet is not recognized correctly if the print is 
too light.

- Do not use thin paper in order to avoid bleed-
through.

Using the same patch code sheets repeatedly may 
decrease the recognition accuracy due to accumulated 
dirt on the sheets. If the patch code sheets are not 
recognized correctly or get smudged, print new patch 
code sheets.

To suppress the sca
select the [Remove 
In Duplex Scan mod
the back side of patc
[Remove the next pa
box.
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4 Insert the patch code sheets wherever you want the file/
folder to separate.
Load the document with the patchcode-printed sheets face down on 
the ADF paper chute.

2 Set [Document Counter], [Folder delimiters], 
[Character string 1], and [Page Counter] in [Settings 
applied].

unter] situated above [Folder 
e folder name, and the scanned 

ved in this folder.
rs] is not set, no folders are 
ument Counter], [Character string 
nter] will be the file name.
 files in folders:

er] as 

ing 
er] as 

image0001.jpg
0001

image0002.jpg

image0001.jpg
0002

image0002.jpg

image0001.jpg
0003

image0002.jpg...

...

...

Saving folders

0001image0001.jpg
0001image0002.jpg

0002image0001.jpg
0002image0002.jpg

0003image0001.jpg
0003image0002.jpg

...

...

...

Saving folders
5 Using the batch profile you created above, perform a 
batch scan.
For how to perform a batch scan, refer to "2.7 Scanning with [Batch 
Scan]" (page 20).

Follow the procedure below to save images of a scanned 
document that are separated by patch code sheets, in 
separate folders.

1 Select the [Use the Name Rule] check box on the 
[File format and Name scheme] tab in the [Profile 
Editor] dialog box, and click the [Name Rule] button.

The [Name Rule] dialog box appears.

Patchcode-printed Sheets

[Document Co
delimiters] is th
images are sa

If [Folder delimite
created, and [Doc
1], and [Page Cou
Example of saving
When specifying 
[Document Count
folder names

When not specify
[Document Count
folder names
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Dividing a Multipage Document Using Barcodes

ScandAll PRO supports the Job Separation function using 
barcode-printed sheets. This function allows you to divide 

The following lists the barcode detection parameters:
Item Parameter

Barcode height 10 to 30 mm / 0.39 to 1.18 inches

81 inches or less

nches or more on each side of 

ay not be recognized correctly 
 the document.)

i

d vertical

ith an undefined barcode type for 
nt may be separated wrongly, and 
 also be deleted depending on the 
this, check the document carefully 
 undefined barcodes. It is 
it the barcode types to be 
rea to detect barcodes.

sheets repeatedly may decrease 
due to accumulated dirt on the 
ets are not recognized correctly or 
arcode sheets. 
 the barcode includes any control 

ters unavailable for a file or folder 
, ", <, >, |, those are replaced with 

eated folder or file name.
recognized correctly depending on 
, the scanner driver settings and/or 
s. Operate after ensuring that the 
nized.
scanned images of a multipage document by a specified unit 
without interrupting the ongoing scan, and save them 
respectively in separate folders. When the output file format is 
set to multipage PDF or TIFF, and multipage document is 
scanned, the pages can be divided by the specified unit and 
saved as separate files. You can create files and folders with a 
name that includes the document counter or the text 
recognized from barcode.

ScandAll PRO can detect the following types of barcodes:
Code Character set Field width

UPC/EAN/
JAN

Numbers UPC:12 (UPC-A only; includes 
check digits)
EAN, JAN: 8 or 13 (includes 
check digits)

CODE39 Numbers, alphabets, 
7 symbols

1 to 32
(excludes start/stop codes)

CODE128 Full ASCII codes 1 to 32
(excludes check characters)

Codabar 4 start/stop 
characters, numbers,
10 alphabets and 
symbols

1 to 32
(excludes start/stop codes)

Barcode length 300 mm / 11.

Barcode margin 5 mm / 0.20 i
barcode

Barcode base color White (This m
depending on

Barcode color Black

Resolution 200 to 600 dp

Barcode angle Horizontal an

！！！
If you scan a document w
this function, the docume
the scanned images may
scan settings. To prevent 
in advance to see if it has
recommended that you lim
detected, and define the a
Using the same barcode 
the recognition accuracy 
sheets. If the barcode she
get smudged, print new b
If the text recognized from
characters and/or charac
name, such as \, /, ,, :, *, ?
"_" (underscore) in the cr
The barcode may not be 
the document (if skewed)
the print status of barcode
barcode is correctly recog
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The procedure is as follows:

1 Scan a sample image for barcode recognition.
For how to perform a scan, refer to "2.6 Scanning with [Scan]" (page 

3 Select the [Document separator] tab, and then select the 
[Use Barcode-Based Job Separation Sheet] check box.

nning of the image of barcode-
 the [Remove separation sheet] 

e, you can disable the scanning of 
ode-printed sheets by selecting 
t page of a separation sheet] 
17) or "2.7 Scanning with [Batch Scan]" (page 20).

2 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

The image created with ScandAll PRO can be used for 
samples.
Details of the conditions are as follows:

Resolution Color format Paper size

200 dpi or 
higher

Monochrome/
8-bit Gray/
24-bit Color

Height and width:
50 to 453 mm

To suppress the sca
printed sheet, select
check box.
In Duplex Scan mod
the back side of barc
the [Remove the nex
check box.
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4 Click the [Setup] button.
The [Barcode Setting] dialog box appears.

5 Click and drag to select the area to detect the barcode.

！！！
To change the sample image to be shown, replace it 
from the [File] menu  [Open].
Barcode type
You can specify the barcode type to be searched for 

enu  [Advanced].

performance deteriorates, limit the 
 detected or narrow the barcode 
scanning performance.
barcodes in the barcode detecting 
ized first will be enabled.

 results
arcode recognition result of the 
the [Barcode] menu  [Recognize 
The selected area is displayed in shaded red. 

6 After you have completed the area selection, select the 
[File] menu  [Exit] to save the setting contents.

！！！
Sample image display
The sample image displayed on the barcode setting 
window is as follows.
- An image which has been displayed once and then 

saved is displayed as a sample image. If no relevant 
image is saved, the last image displayed on the 
main window is used as a sample image. If there is 
no image displayed on the main window, select the 
[File] menu  [Open] to select a sample image.

- Bitmap or JPEG (except Progressive JPEG) files are 
available.

from the [Barcode] m

If barcode scanning 
barcode types to be
area to improve the 
If there are multiple 
area, the one recogn
Barcode recognition
You can check the b
sample image from 
Barcode].
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7 Insert the barcode-printed sheets wherever you want the 
file/folder to separate.
Load the document with the barcode-printed sheets face down on the 
ADF paper chute.

n sheet] situated above [Folder 
e folder name, and the scanned 

ved in this folder.

rs] is not set, no folders are 
ument Counter], [Character string 
nter] will be the file name.
 files in folders:

[Job 
 as 

ing 
heet] 

image0001.jpg
January

image0002.jpg

image0001.jpg
February

image0002.jpg

image0001.jpg
March

image0002.jpg

...

...

...

Saving folders

Januaryimage0001.jpg
Januaryimage0002.jpg

Februaryimage0001.jpg
Februaryimage0002.jpg

Marchimage0001.jpg
Marchimage0002.jpg

...

...

...

Saving folders
8 Using the batch profile you created above, perform a 
batch scan.
For how to perform a batch scan, refer to "2.7 Scanning with [Batch 
Scan]" (page 20).

Follow the procedure below to save images of a scanned 
document that are separated by barcode-printed sheets, 
in separate folders, and name each folder with a 
character string recognized from the relevant barcode:

1 Select the [Use the Name Rule] check box on the 
[File format and Name scheme] tab in the [Profile 
Editor] dialog box, and click the [Name Rule] button.

The [Name Rule] dialog box appears.

2 Set [Job separation sheet], [Folder delimiters], 
[Character string 1], and [Page Counter] in [Settings 
applied].

 

 

  
  

Barcode-printed
Sheets

[Job separatio
delimiters] is th
images are sa

If [Folder delimite
created, and [Doc
1], and [Page Cou
Example of saving

When specifying 
separation sheet]
folder names

When not specify
[Job separation s
as folder names
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Using the Scanner Buttons to Start a Scan 
Quickly

You can perform a scan simply by pressing the [Scan] or 

6 Select the [Events] tab, and then select the event.
From the [Select an event] menu, select the event that you want to 
launch an application for.

cted:
can] button is pressed)
 [Send to] button is pressed while a
isplayed on the operator panel)

 the operator panel depend on the 

 

[Send to] button on the scanner. To do this, you first need to 
assign your desired scanning applications to these buttons.
Computer Settings

1 Confirm that the scanner is connected properly to your 
computer, then power on the scanner.
For how to connect the scanner to your computer, refer to the 
Operator’s Guide for the scanner you are using.

2 Select the [Start] menu  [Control Panel].
The [Control Panel] window appears.

3 Select the [Hardware and Sound] icon.
The [Hardware and Sound] window appears.

4 Select the [Scanners and Cameras] icon.
The [Scanners and Cameras] window appears.

5 Display the properties of the scanner.
Double-click the scanner icon.

The following events can be sele
Scan Button (when the [S
Send to 1 to n (when the
number (from 1 to n) is d

！！！
Numbers displayed on
selected scanner.
Example: Send to 1 - 9
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7 Select the application to be launched when an event 
occurs.
Select the [Start this program] option button under [Actions], and then 
select the application you want to use.

9 Start up ScandAll PRO.

10 Select the [Tool] menu  [Preferences].
The [Setup] dialog box appears.

nt you selected in Step 6, and 
e list you want to use for 

 required profile beforehand.
les, refer to "2.7 Scanning with 
).
8 Click the [OK] button.
This completes the computer settings for an application other than 
ScandAll PRO. Then, configure settings for your scanner according to 
"Scanner Settings" (page 36).

11 Select the [Event] tab.

12 Select the action for the eve
then select a profile from th
scanning.

13 Click the [OK] button.

14 Exit ScandAll PRO.

The screens and operations may differ slightly if the 
operating system that you are using is other than 
Windows Vista.
If you want to link with other buttons here, repeat Steps 
6 to 7, and finally perform Step 8.

You need to create the
For how to create profi
[Batch Scan]" (page 20
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When you press the linked button, ScandAll PRO starts up, 
and a batch scan is executed according to the selected 
profile's settings.

！！！
Depending on the scanner you are using, the profile name 
specified as [Send to 1 to n] in Step 12 is displayed on the 
operator panel. However, the profile name is not displayed 
correctly if...

age that the scanner does not 
guages are displayed with ■) 
 the display range (16 characters × 
Scanner Settings

 

When using the [Scan] button
No setting changes are needed.

Pressing the [Scan] button starts up the application you selected.

When using the [Send to] button
Press the [Function] button to change the number displayed on the 
operator panel.
Match the event set at the computer (Send to 1 to n) and the number.
To perform the event configured with [Send to 2], for example, display 
[2] on the operator panel.

Pressing the [Send to] button starts up the application you 
selected.

Operator panel specifications differ depending on the scanner.
For details, refer to the Operator’s Guide for the scanner you 
are using.

Function

Hopper  Height

Paper  Thickness
Thin

Send to Scan

Thick

ADF Type

[Send to] Button
[Scan] Button

Function Send to Scan Power

Flatbed Type

[Send to] Button

[Scan] Button

the name is set in a langu
support (Unsupported lan
the name does not fit into
3 rows)
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Specifying the Result of Zone OCR as a File 
Name

ScandAll PRO supports the Zone OCR function. With this 

The procedure is as follows:

1 Scan a sample image for Zone OCR.
For how to perform a scan, refer to "2.6 Scanning with [Scan]" (page 

Scan]" (page 20).

n ScandAll PRO, and then 
log box.
 "2.7 Scanning with [Batch Scan]" 

 ScandAll PRO can be used for 

s are as follows:

r format Paper size

ochrome/
 Gray/
it Color

Height and width:
50 to 453 mm
function, you can perform Zone OCR on a specified area of a 
scanned document and output the recognition result to a file. 
You can also use character strings recognized by the Zone 
OCR as a file name or folder name.
This section explains how to set the character strings 
recognized by Zone OCR as a file name.

17) or "2.7 Scanning with [Batch 

2 Create a new batch profile i
open the [Profile Editor] dia
For how to create profiles, refer to
(page 20).

The following resolutions are recommended for images. 
Resolution higher than 600 dpi cannot be recognized for 
Color/Gray.
- Monochrome: 400/600 dpi
- Color/Gray: 200/300 dpi
The deskew function of the driver and the orientation 
correction filter may improve the recognition rate. 

The image created with
samples.
Details of the condition

Resolution Colo

200 dpi or 
higher

Mon
8-bit
24-b
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3 Select the [Filter] tab, and then select the [Enable Zone 
OCR] check box.

5 Click and drag to select an area for Zone OCR.

 in shaded red. 

e area selection, select the 
 the setting contents.

y
isplayed on the Zone OCR setting 
.
as been displayed once and then 
d as a sample image. If no relevant 
e last image displayed on the 

sed as a sample image. If there is 
d on the main window, select the 
en] to select a sample image.

except Progressive JPEG) files are 

le image to be shown, replace it 
  [Open].
4 Click the [Settings] button.
The [Zone OCR Settings] dialog box appears.

The selected area is displayed

6 After you have completed th
[File] menu  [Exit] to save

Sample image displa
The sample image d
window is as follows
- An image which h

saved is displaye
image is saved, th
main window is u
no image displaye
[File] menu  [Op

- Bitmap or JPEG (
available.

To change the samp
from the [File] menu
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8 Set [Character string 1], [Page Counter], and [Zone OCR] 
in [Settings applied].

unter], and [Zone OCR] are used for 

anner.

created above, perform a 

 refer to "2.7 Scanning with [Batch 

Zone OCR advanced settings
You can specify advanced settings for Zone OCR from 
the [Zone OCR] menu  [Advanced]. For information 
about the setting items you can configure, refer to the 

n using the character strings 
R as a file name.

can be recognized.
 : ? * " < > | , ) are replaced with "_" 

 are deleted.
le page type file, include [Page 
ame. If the page counter is not 
e may be duplicated.

e files are created, the character 
the Zone OCR on the top page will 
ame.
7 Click the [Name Rule] button on the [File format and 
Name scheme] tab in the [Profile Editor] dialog box.

The [Name Rule] dialog box appears.

 [Character string 1], [Page Co
the file name.

9 Load a document on the sc

10 Using the batch profile you 
batch scan.
For how to perform a batch scan,
Scan]" (page 20).

ScandAll PRO Help.

Zone OCR results
You can check the sample image Zone OCR result 
from the [Zone OCR] menu  [Zone OCR]. Note the following whe

recognized by Zone OC
Up to 32 characters 
Illegal characters (\ /
(underscore).
Line feed characters
If outputting the sing
Counter] to the file n
included, the file nam
When multipage typ
string recognized at 
be used for the file n
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Confirm and correct zone OCR results.
When the [Confirm and correct zone OCRed text] 
check box is selected for [Zone OCR Advanced 
Settings], the [Zone OCRed Text Confirmation and 

Correction] dialog box is displayed when a batch scan 
is performed. You can confirm and correct zone OCR 
results in this dialog box.
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Specifying the Result of Barcode Recognition as 
a File Name

ScandAll PRO supports the barcode recognition function. With 

3 Select the [Filter] tab, and then select the [Perform 
barcode recognition] check box.

ox appears.
this function, you can perform barcode recognition on a 
specified area of a scanned document and output the 
recognition result to a file. You can also use character strings 
recognized with barcode recognition as a file name or folder 
name.
This section explains how to set a character string recognized 
with barcode as a file name.

The procedure is as follows:

1 Scan a sample image for barcode recognition.
For how to perform a scan, refer to "2.6 Scanning with [Scan]" (page 
17) or "2.7 Scanning with [Batch Scan]" (page 20).

2 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

4 Click the [Settings] button.
The [Barcode Setting] dialog b

The recommended resolution for an image to be used for 
barcode recognition is 200 to 600 dpi.

The image created with ScandAll PRO can be used for 
samples.
Details of the conditions are as follows:

Resolution Color format Paper size

200 dpi or 
higher

Monochrome/
8-bit Gray/
24-bit Color

Height and width:
50 to 453 mm
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5 Click and drag to select an area for barcode recognition.

n on the [File format and 
rofile Editor] dialog box.
ppears.

Barcode properties
You can specify advanced settings for barcode 
recognition from the [Barcode] menu  [Advanced]. 
For information about the setting items you can 

e ScandAll PRO Help.

 results
ample image barcode recognition 
ode] menu  [Recognize 
The selected area is displayed in shaded red. 

6 After you have completed the area selection, select the 
[File] menu  [Exit] to save the setting contents.

7 Click the [Name Rule] butto
Name scheme] tab in the [P

The [Name Rule] dialog box a

Sample image display
The sample image displayed on the barcode setting 
window is as follows.
- An image which has been displayed once and then 

saved is displayed as a sample image. If no relevant 
image is saved, the last image displayed on the 
main window is used as a sample image. If there is 
no image displayed on the main window, select the 
[File] menu  [Open] to select a sample image.

- Bitmap or JPEG (except Progressive JPEG) files are 
available.

To change the sample image to be shown, replace it 
from the [File] menu  [Open].

configure, refer to th

Barcode recognition
You can check the s
result from the [Barc
Barcode].
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8 Set [Character string 1], [Page Counter], and [Barcode] in 
[Settings applied].
[Character string 1], [Page Counter], and [Barcode] are used for 
the file name.

9 Load a document on the scanner.

10 Using the batch profile you created above, perform a 
batch scan.
For how to perform a batch scan, refer to "2.7 Scanning with [Batch 
Scan]" (page 20).

Note the following when using the character strings 
recognized with barcode recognition as a file name.

Up to 32 characters can be recognized.
Illegal characters (\ / : ? * " < > | , ) and spaces for the 
top or end are replaced with "_" (underscore).
Line feed characters are deleted.
If outputting the single page type file, include [Page 
Counter] to the file name. If the page counter is not 
included, the file name may be duplicated.
When multipage type files are created, the character 
string recognized with the barcode recognition on the 
top page will be used for the file name.
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Creating Saving Folders for Each Batch Scan

If the same batch profiles are used consecutively, multiple files 
with same file name are created and may overwrite the 
p
W
m
t

T

1

2

3 Load a document on the scanner.

4 Using the batch profile you created above, perform a 
batch scan.

ed, the [Batch Folder Name] dialog 

refer to "2.7 Scanning with [Batch 

nd click the [OK] button.

canned image file is saved in the 
d name.

h folders include a number of 8 or 
mes are created by adding "1" to 

 number. In the case where 
se the number of digits, the 
stead.
a number of more than 8 digits at 
es not vary.

er Next batch folder name

Batch_0010
Batch_0001
Batch_000000001
revious batch scan output file.
ith ScandAll PRO, in order not to overwrite the file, you can 
ake a setting to create folders for saving image files each 

ime a batch scan is executed.

he procedure is as follows:

Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

Select the [File format and Name scheme] tab, and then 
select the [Use a batch folder] check box.

When the batch scan is execut
box appears.

For how to perform a batch scan, 
Scan]" (page 20).

5 Enter a batch folder name, a

The batch scan starts and the s
created folder with the specifie

If the names of the batc
less digits at the end, na
the previously specified
adding "1" would increa
number returns to "1" in
If folder names include 
the end, the number do
Example:

Specified batch fold
name

Batch_0009
Batch_9999
Batch_000000001
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Example of saving files in folders:
When using folders created for 
each batch scan image0001.jpg

Batch_0001

image0002.jpg...

Saving folders
image0001.jpg
Batch_0002

image0002.jpg

image0001.jpg
Batch_0003

image0002.jpg

...

...
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Saving Scanned Images from a Batch Scan to a 
Microsoft SharePoint Server

2 Click the [Linking] tab, and select the [Link up with the 
following process] check box.

SharePoint Server] and click 

 the SharePoint Server] dialog box 

ng the scanned images to the 
.

tor] dialog box.
With ScandAll PRO, you can perform a batch scan and save 
the scanned image file to a Microsoft SharePoint server.

The procedure is as follows:

1 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

3 Select [Upload to Microsoft 
the [Setup] button.

The [Information to transfer to
appears.

4 Specify the settings for savi
Microsoft SharePoint server

5 Click the [OK] button.
This returns to the [Profile Edi

！！！
The server on which Microsoft SharePoint Server is run 
requires some ScandAll PRO modules to be installed. In order 
to install the modules in a server, obtain 
"ScandAllPROSrv.exe" from the [ScandAll] folder in the Setup 
DVD-ROM, and execute it on the server.
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6 Load a document on the scanner.

7 Using the batch profile you created above, perform a 
batch scan.
When the batch scan is executed, the image file is saved in the 
Microsoft SharePoint server.

For more information, refer to the ScandAll PRO Help.
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Restarting a Suspended Batch Scan

With ScandAll PRO, when a "batch scan" is performed, the 
batch scan working state is temporarily saved automatically

ved batch scan working state 

Restore Batch Scan].
st] dialog box appears.

nt to restore, and click the 

cted batch scan is restored on the 
 additional operations for the batch 

ning or image editing.

Restore the saved working 
state and restart the batch 
scan

o the ScandAll PRO Help.
If you want to restart the batch scan, select the [Scan] menu  
[Restore Batch Scan] for the saved batch scan working state. 
After restoration, you can restart the scanning.
For example, you can continue the interrupted batch scan the 
next day. Similarly, if another more urgent scan needs to be 
performed while a batch scan is running, its working state can 
be saved, allowing it to be restarted at a later time.

The procedure to restore the sa
is as follows:

1 Select the [Scan] menu  [
The [Saved batch scan data li

2 Select a batch scan you wa
[Restore] button.

The working status of the sele
main window. You can perform
scan, such as additional scan

Perform a batch scan
(Automatically saved)

Perform a different scan 

For more information, refer t
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Outputting Indexing Information File and Linking 
with an Application

With ScandAll PRO, you can output the result of Zone OCR 

3 In the [Profile Editor] dialog box, select the [Linking] tab, 
and then select the [Output indexing information] check 
box. To set the file name and file type to be output, click 
the [Set Indexing Info] button, and set in the [Set Indexing 

 files are saved in the folder 
r Name] in the [File format and 
in the [Profile Editor] dialog box.
tch folder] check box is selected, 
 files are output to the batch folder.
 files are of the following types.
t the details of file types, refer to 
elp.
at 

h:mm:ss [TAB] file name [TAB] 
AB] "Zone OCR recognition 

arcode recognition result"

 hh:mm:ss", "file name", "page 
 OCR recognition result", 
nition result"
and the barcode recognition result to the indexing information 
file. You can specify an application to be launched and a 
parameter to pass the name of the indexing information file to 
the application.
This function allows you to create a batch profile, such as for 
saving image data with indexing information in the server. 

The procedure is as follows:

1 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

2 Set the barcode or Zone OCR in the [Profile Editor] dialog 
box.
For details on how to set a barcode, refer to "Dividing a Multipage 
Document Using Barcodes" (page 30). For details on how to set Zone 
OCR, refer to "Specifying the Result of Zone OCR as a File Name" 
(page 37). 

Info] dialog box.

Indexing information
specified with [Folde
Name scheme] tab, 
When the [Use a ba
indexing information
Indexing information
For information abou
the ScandAll PRO H
- Unicode Text form

- CSV format 

YYYY/MM/DD h
page number [T
result" [TAB] "b

"YYYY/MM/DD
number", "Zone
"barcode recog
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4 In the [Profile Editor] dialog box, select the [Link up with 
the following process] check box on the [Linking] tab, and 
then select the [Launch another application] option button. 
Click the [Setup] button, and specify the application to be 

ogram] and %i for [Argument-
ialog box.

anner.

created above, perform a 

, ScandAll PRO launches the 
exing information file name to the 

 refer to "2.7 Scanning with [Batch 

- XML format 

<?xml version = "1.0" encoding = "utf-8"?>
<root>
launched for [Application Pr
Parameter] in the [Option] d

5 Load a document on the sc

6 Using the batch profile you 
batch scan.

After the document is scanned
application and passes the ind
application as a parameter.

For how to perform a batch scan,
Scan]" (page 20).

<page>
<item name = "Date&time" value = "date and 
time" />
<item name = "Full Path" value = "file name (full 
path)" />
<item name = "Page Number in Document" value 
= "page number in document" />
<item name = "Zone OCR" value = "zone OCR 
result" />
<item name = "Barcode" value = "barcode 
recognition result" />
</page>
<page>
<item name = "Date&time" value = "date and 
time" />
<item name = "Full Path" value = "file name (full 
path)" />
<item name = "Page Number in Document" value 
= "page number in document" />
<item name = "Zone OCR" value = "zone OCR 
result" />
<item name = "Barcode" value = "barcode 
recognition result" />
</page>
.
.
</root>
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Detecting Errors in the Scanned Document 
(fi-6800)

If an error is detected in the scanned document, the 

When selecting the [Mark pages when error is detected by 
Automatic Image Quality Checker] check box
The scanned document is checked for any folds or tears.
If an error is detected, it is indicated by changing the background 

ontaining the error to yellow.
s when multifeed is detected] check 

cked for any errors where multiple 
re sheets of different lengths are 

 while scanning, the scan is 
ter all scans are completed, the 
changing the background of the 
ing the error to red.

ttings] button on the [Scan] 
rameters.
s when error is detected by 
ker] check box

Settings

e [Rotation] tab in the [Option] 
 box displayed by clicking the 
n] button, select [Automatic Page 
etection] or [Black Background] 

utomatic Size and Skew detection].

gure the parameter as either of the 
ing:
lect [Automatic], [Deskew], or 
ng Page] for [Cropping] on the 
in] tab.

lect [Black] for [Backing] on the 
per Handling] tab.
background color of the thumbnail changes automatically so 
that the user can recognize the target image easily.

The procedure to set the automatic error detection and 
notification is as follows:

1 Create a new batch profile in ScandAll PRO, and then 
open the [Profile Editor] dialog box.
For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" 
(page 20).

2 On the [Scan] tab, select the [Mark pages when error is 
detected by Automatic Image Quality Checker] and [Mark 
pages when multifeed is detected] check boxes, and click 
the [OK] button.

of the thumbnail for the page c
When selecting the [Mark page
box
The scanned document is che
pages are fed at a time or whe
fed.
If a multifeed error is detected
continued without stopping. Af
multifeed error is indicated by 
thumbnail for the page contain

3 Click the [Detail Scanner Se
tab to configure the scan pa

When selecting the [Mark page
Automatic Image Quality Chec

Scanner driver

TWAIN driver On th
dialog
[Optio
Size D
for [A

ISIS driver Confi
follow

Se
[Lo
[Ma
Se
[Pa
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When selecting the [Mark pages when multifeed is detected] check 
box

7 Using the batch profile you created above, perform a 
batch scan.

If there is an error in the scanned document, the target thumbnail 
is displayed with background of a different color.Scanner driver Settings

ned image with an error by 
nu  [Replace]  [Scan].

r or shape of the document, errors 
take or fail to be recognized, since 
in the corners of the scanned 

 scanned image yourself even 
ction function.

 

Detected
Fold
4 When you have completed the settings, click the [OK] 
button.

This returns to the [Profile Editor] dialog box.

5 Click the [OK] button in the [Profile Editor] dialog box to 
add the profile.

6 Load a document on the scanner.

TWAIN driver On the [Job/Cache] tab in the [Option] 
dialog box displayed by clicking the 
[Option] button, select [Check 
Overlapping (Ultrasonic)], [Check 
Length], or [Check Overlapping and 
Length] for [Multifeed Detection].

ISIS driver On the [Multifeed Detection] tab, select 
[Paper Overlap] or [Paper Length] for 
[Multifeed Detection].

You can replace a scan
selecting the [Page] me

！！！
Depending on the colo
may be detected by mis
they are detected only 
image.
Make sure to check the
when you use this dete
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age, select an option from the 

2.9 Useful Post-Scan Functions

Used to...

play the previous marked page.

play the next marked page.

play the first marked page.

play the last marked page.

ark the selected thumbnail.

ark all thumbnails.

 thumbnail by right-clicking and 
cted Pages] while the thumbnail is 
Marking Thumbnails

This function is useful to distinguish a certain desired image 
from others.

The procedure is as follows:

1 Load a document on the scanner and perform a scan.

2 Select the thumbnail of the desired image, and then select 
the [Mark] menu  [Mark].

The background of the selected thumbnail turns to 
orange.

3 After marking the desired im
following:

You can also mark a thumbnail with orange background 
by right-clicking and selecting [Mark Selected Pages] 
while the thumbnail is selected.

Menu option

Previous Marked Page Dis

Next Marked Page Dis

First Marked Page Dis

Last Marked Page Dis

Unmark Unm

Unmark All Unm

You can also unmark a
selecting [Unmark Sele
selected.
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Saving Scanned Images to a Microsoft 
SharePoint Server

You can save scanned images to a Microsoft SharePoint 

server.

The procedure is as follows:

1 Load a document on the scanner and perform a scan.

2 Select the [File] menu  [Send]  [Microsoft SharePoint].
The [Scan to Microsoft SharePoint] dialog box appears.

3 Save the scanned images to the Microsoft SharePoint 
server.
For more information, refer to Scan to Microsoft SharePoint User 
Guide.
You can view Scan to Microsoft SharePoint User Guide by selecting 
the [Start] menu  [KnowledgeLake]  [Scan to Microsoft SharePoint 
User Guide].

！！！
Scan to Microsoft SharePoint needs to be installed.
If not, install it referring to [Readme] from the [Start] menu  
[All Programs]  [Fujitsu ScandAll PRO].
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